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Batch Table Wrapper User Guide 

1. Introduction 
The Batch Table Wrapper is used by SIMCA, SIMCA-Batch On-Line or SIMCA-online to create the 

batch information table or Batch Node as it is referred to in SIMCA and SIMCA-online. The batch 

node is used to determine when batches are executing, i.e. the start and stop times for the batches. 

The Batch Table Wrapper creates a database from a Batch ID tag and a logical start and stop condition 

based on tags in the process. A useful side effect with the Batch Table Wrapper is that the user can 

append or prepend the start date/time to the Batch name. This is needed when the system has recurring 

batch names so that SIMCA-online can know which batch has run at a certain time. 

The Batch Table Wrapper cannot be used alone. It needs data from another SimApi that connects to a 

process database to be able to generate the batch node. The SimApi that is used must support reading 

both current and historical data since this is required in order to create the batch information. Note: 

when used with the IP21 SimApi make sure the Include Bounds setting is set to false, see 2.3.5.5 

Include Bounds. 

Note that the Batch Table Wrapper cannot have more than one batch running in the internal batch table 

at once for each Generated Batch Node that is used. This will limit some of the functionality inside of 

SIMCA-online. 

The Batch Node that is maintained by the SimApi consists of three required fields and zero or more 

optional fields; 

 BatchID - Generated from a process batch tag, and in if needed any part of the start timestamp 

 Start Time of the batch - Generated from a process data driven trigger 

 Stop Time of the batch - Generated from a process data driven trigger 

 In addition, any number of Batch Conditions (batch data variables) can be added. Batch 

conditions will be read at the start time of the batch from the process data source. 

Note that reading process data through the Batch Table Wrapper is a bit slower than reading data 

through a dedicated SimApi connection. 

1.1 Features 

 Generated batch node – a batch node that is created from continuous process data. 

 Mirrored batch node – Used with an OSIsoft PI server to wrap around an existing batch node 

to work around recurring batch names.  

 Multiple instances of the Batch Table Wrapper SimApi on the same SIMCA-online server. 

This lets you connect to multiple data sources and use the Batch Table Wrapper functionality 

on each. 

 Possibility to specify the instance name for the configured SimApi to be used in Batch Table 

Wrapper. 

1.2 Installation 
The SimApi comes in a 32-bit (x86) and a 64-bit (x64) version. Use the one that matches the program 

(for example SIMCA-online or SIMCA) you will use the SimApi in. 

1. Run the SimApi setup program to install the SimApi on your computer where you want to use 

it. 

2. Set up the SimApi as described in 2 below. 
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Also refer to the following sections for information on important locations for log- and settings files 

and troubleshooting tips.  

1.1 Configuration file and log file locations 
The SimApi stores its settings in a XML settings file named BatchTableWrapperConfiguration.xml in 

the Program Data folder
1
. This folder is located in different places depending on the Windows 

version: 

Window Vista and Windows Server 2008 and later: C:\ProgramData\Umetrics\SimApi 

Windows XP: C:\Documents and Settings\All Users\Application Data\Umetrics\SimApi 

This folder also contains the log file that the SimApi writes. This log file is named 

BatchTableWrapperSimApiLog.log and is useful for troubleshooting. 

 

1.1.1 File names when multiple instances is used with SIMCA-online 13.1 or later 

When multiple instances is used with SIMCA-online 13.1 or later versions, each configuration get its 

own configuration file and log file, the naming of these files corresponds to the name the configuration 

is given on the SimApi tab in the SIMCA-online server options dialog and are therefore a bit different 

than what is mentioned in the previous section. The following example shows the naming of these 

files. 

Configuration name given when the instance is added: Server1 

Configuration file name: BatchTableWrapper_Server1Configuration.xml 

Log file name: BatchTableWrapper_Server1SimApiLog.log 

Note that the generic file BatchTableWrapperSimApi.log file still is used. This log file contains entries 

that for technical reasons cannot be directed to the log file of the instances. 
 

2. Setting up 
In order for SIMCA or SIMCA-online to be able to use the SimApi you need to configure it as 

described here. 

2.1 Using this SimApi in SIMCA 
Start SIMCA-import by File->New Regular Project->New Batch Project. If the database import 

wizard is not opened automatically, open it from File->New Spreadsheet->From Database. Click on 

Add data source. 

                                                      
1
 This folder is normally hidden in Windows so in order to see it in Windows Explorer you should configure 

Windows Explorer to show hidden files. Note that you still can navigate to a hidden folder by copying and 

pasting the folder path to Explorer’s address bar. 
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Select SimApi as connection type, find the installed BatchTableWrapper.dll and click on Configure… 

button and the Batch Table Wrapper Configuration is opened. Continue to 2.3 below. 

 

2.2 Using this SimApi in SIMCA-online Server 
Start the SIMCA-online Server Options utility from the start menu. Go to the SimApi tab and click 

Add...  
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Enter a name, browse to and select the BatchTableWrapper.dll. Click the Configure… button and the 

Batch Table Wrapper Configuration dialog is opened. It is described next. 

2.3 Batch Table Wrapper Configuration 

 

The configuration consists of Output Directory (optional), SimApi configuration, SimApi instance 

name (optional) and one or more Batch Node configurations.  

Batch Node can be added / removed by the clicking Add Generated, Add Mirrored or Remove Node 

buttons in the Node group.  

Note: At least one batch node needs to be configured. 

The various fields you can provide are described below: 

2.3.1 Output Directory (Optional) 

Output directory is where the database file(s) will be stored, if several instances of the Batch Table 

Wrapper is used each will use its own database file. This setting is optional meaning if this field is left 
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empty the database file(s) will be stored in the default location which is 

%ProgramData%\Umetrics\SimApi\BatchTableWrapper. The naming of the database file corresponds 

to the name the configuration is given on the SimApi tab in the SIMCA-online server options dialog 

with the extension .db. For instance is the configuration is named BTW the database file name will be 

btw.db. The database is a SQLite database. It can be opened with an external program that understands 

SQLite, for example “SQLiteBrowser”. 

If you want to redo the configuration of the Batch Table Wrapper you should remove all old batch 

records from the database so that it will be created from scratch. This can be done by clicking the 

Remove All button in the configuration dialog. Otherwise old batches will remain and can conflict 

with the new ones generated after changing the settings. 

2.3.2 SimApi 

Select the SimApi to use for obtaining the process data used by the Batch Table Wrapper by clicking 

the … button to browse to and select the SimApi dll. 

If a configuration of the selected SimApi is needed click the Config button and follow the instructions 

for that SimApi. 

2.3.3 Instance name (Optional) 

When using Batch Table Wrapper with a SimApi that support multiple instances of itself with each 

instance having a unique name, this setting can be used in order to connect to a specific instance. The 

instance name is the name given for a configured SimApi on the SimApi tab in the SIMCA-online 

Server Options dialog. Make sure to configure the SimApi after this field is filled out so the correct 

configuration file is used. 

2.3.4 Generated Batch Node 

The generated batch node is used when the real process SimApi does not provide its own batch node.  

A start and stop trigger using continuous process tags will be used to set the start and stop times of 

batch node that is created in the Batch Table Wrapper SimApi itself. 

The batch node created is populated both at startup and when SIMCA-online is executed. At startup it 

will go back the configured time (Maximum Backlog) and look for batches after that it will keep 

updating the batch node for every configured time interval. It will also go back in time and look for 

batches if SIMCA-online asks for batches via the repredict dialog. If a batch was active during the 

Maximum Backlog time it should be available immediately after startup in the extract tool. 

2.3.4.1 Batch Node Name 

The Batch Node Name will be used in SIMCA-online for project configurations and in SIMCA to 

setup the data export. In the SIMCA-online project configuration select this batch node name as the 

desired Batch Node, and also as the unit’s Batch Identifier Tag (see 3.1 below).  

If you set up several batch nodes, each Batch Node has to have a unique name. 

2.3.4.2 Batch ID Tag 

The Batch Identifier Tag is used to retrieve the name of the batch from selected SimApi (2.3.2).  Click 

the (…)-button to show a dialog with available tags and select one as the Batch ID Tag. The tag is 

allowed to contain numeric or string values. 

The Batch Table Wrapper then will generate the new batch id to be shown in SIMCA-online using the 

value from the Batch ID Tag combined with Batch Name Affix (see 2.3.4.3). 

This tag can be left empty, however this requires that an affix and start and stop trigger is configured. 

When this feature is used the string Batch will be used together with the affix so the batch name will 

look something like this:  

Batch_20160510_1230 
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2.3.4.3 Batch Name Affix 

Batch Name Affix should be used when same batch name can occur more than once in the process 

data. This is required because SIMCA-online expects unique batch names.  

Batch Name Affix is optional. When creating batch name affix the batch start time is used and the 

supported format specifiers are: 

   %Y - Year with century, as decimal number 

   %m - Month as decimal number (01 - 12) 

   %d - Day of month as decimal number (01 - 31) 

   %H - Hour in 24-hour format (00 - 23) 

   %M - Minute as decimal number (00 - 59) 

   %S - Second as decimal number (00 - 59) 

   %b - Abbreviated month name 

   %B - Full month name 

The batch name shown in SIMCA-online will be the value stored in the Batch ID Tag (2.3.4.2) 

combined with Batch Name Affix. 

Note that any characters can be used as well to get the desired batch name. For instance “%d_;” would 

become 23_B1 if the date was the 23rd and the original batch name was B1. 

2.3.4.4 Data read interval = Execution interval 

The interval (in seconds) determines how often data is read from the SimApi to generate the batch 

node. The same interval should be used as in the execution interval used in the project configuration in 

SIMCA-online. 

The Interval must be greater than 0. 

2.3.4.5 Maximum Backlog 

The Maximum Backlog (in seconds) is how far back the SimApi will look when started for a batch 

that is active. 

The value has to be at least the same size as of the length of a typical batch. Good value is 1-2 times 

the normal length of a batch. 

The Maximum Backlog must be set higher than 0. 

2.3.4.6 Start Trigger 

Start Trigger expression specifies when a batch starts. If this is not used the expression can be set to 

true. 

Build an expression by clicking on the three dots (…). Select a tag, logical expression and a value. 

Click Add to build expression. Several conditions can be added to the expression with an And or Or 

separator. Available tags depend on the configured SimApi (2.3.2) and can be either a numeric value 

or a string value. 

Note that this is a trigger and not a condition, meaning that the trigger expression does not need to be 

fulfilled throughout the batch. Once the trigger expression is met the batch will be created and run 

until the Stop Trigger expression is met or if the Batch ID Tag changes. 

2.3.4.7 Stop Trigger 

Stop Trigger expression specifies when a batch stops. If this is not used the expression can be set to 

false. 

Build an expression by clicking on the three dots (…). Select a tag, logical expression and a value. 

Click Add to build expression. Several conditions can be added to the expression with an And or Or 
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separator. Available tags depend on the configured SimApi (2.3.2) and can be either a numeric value 

or a string value. 

2.3.4.8 Batch Conditions 

Selected Batch Conditions are visible in SIMCA-online project configuration as tags and these tags 

should be used as batch conditions when applicable. 

Add batch condition by clicking on the three dots (…). A dialog is shown where one or more tags can 

be selected as batch conditions by marking in the tag list. Available tags depend on the configured 

SimApi (2.3.2) and only numerical values can be used. 

Remove a batch condition by clicking X. 

Batch conditions are optional and should be specified when batch conditions are used in SIMCA-

online projects. 

2.3.5 Mirrored Batch Node – Only for PI SimApi 

A mirrored batch node can be used to allow SimApi’s to have recurring batch names. The configured 

SimApi (2.3.2) will then have to have an already existing Batch Node. The wrapper will then add an 

affix to the batch name from the SimApi with part of or the complete date when the batch began. This 

way, all batch names will be unique from SIMCA-online’s point of view. This functionality will have 

a penalty of about 50ms per phase and observation. 

When this feature is used the Batch Table Wrapper looks at the actual values that are read for process 

data (BatchID for instance that is needed in SIMCA-online for Phase Conditions) and compare those 

values with the original batch names (without the affix) that are kept in the internal database, if the 

value matches with a batch name, the value is replaced with the batch name including the affix. 

Current implementation only supports the PI SimApi made by OSIsoft since this system supports a 

hint time that is used in order to get the correct start and stop times for a batch. 

2.3.5.1 Select Batch Node 

When the SimApi is correctly configured, a list with available nodes from the SimApi will be 

available in the drop down menu. Select the Batch Node that needs to be mirrored. 

2.3.5.2 Batch Name Affix 

See 2.3.3.3. 

2.3.5.3 Interval 

The interval is the time between each time point in the unit seconds when reading data from selected 

SimApi (2.3.2).  The same interval should be used in the SIMCA-online project configuration. 

The Interval must be set higher than 0. 

2.3.5.4 Batch Time Offset 

This is a time value (in seconds) that specifies how far back the Batch Table Wrapper will look for a 

batch. Without this offset sometimes batches are not found due to how the OSIsoft PI SimApi works. 

This offset should be set to the same as the batchtimeoffset value in the PI SimApi ini-file. See the 

OSIsoft PI documentation for more on batch time offset in PI. 

It is important that the specified offset is shorter than the shortest delay between batches, otherwise the 

Batch Table Wrapper might get the wrong batch when querying PI for details about a batch. 

(A note on the BatchTableWrapper.xml file: The value for Batch Time Offset is stored in the 

MaxBacklog attribute used for a generated batch node). 
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2.3.5.5 Include Bounds 

This setting is default set to 1 (true) and should only be changed to 0 (false) when the Batch Table 

Wrapper is used with the IP21 SimApi. This must be done so current data is read for the last time 

point instead of historical value for the same time (resulting in missing data).  

To change this setting open up the configuration file (BatchTableWrapperConfiguration.xml) located 

in C:\ProgramData\Umetrics\SimApi with a text editor (Notepad) and locate the IncludeBounds 

setting for the current node. Change the setting accordingly and save the file. 

2.3.5.6 Empty batch id does not end an ongoing batch 

If you don’t want an ongoing batch to end when the value for the batch id tag changes to empty 

change this setting to 0 (false). The batch will then be ended by the stop trigger condition or if the 

value for the batch id tag is changed to another valid value. 

To change this setting open the regular configuration file with a text editor (Notepad) and locate the 

EmptyBatchIDEndsBatch setting in the BatchNode XML section. If you can’t find this setting please 

open the Batch Table Wrapper configuration dialog and click OK to save the default configuration 

file. The default setting is set to 1 (true). 

2.3.5.7 Read configuration settings from another location 

This setting is default set to empty and should only be changed if you need to read the configuration 

file from another location than the ordinary (C:\ProgramData\Umetrics\SimApi). Note that the regular 

configuration file (BatchTableWrapperConfiguration.xml) must be present in the ordinary location. 

To change this setting open the regular configuration file with a text editor (Notepad) and locate the 

Configuration setting in the Paths XML section. If you can’t find this setting please open the Batch 

Table Wrapper configuration dialog and click OK to save the default configuration file. Change the 

setting to the location where you want to read the BatchTableWrapperConfiguration.xml from, the file 

name should not be present in the path. Copy the regular configuration file to the configured path, now 

any changes made in the Batch Table Wrapper configuration dialog will be saved in the specified 

location. 

3. Setup in SIMCA-online 

3.1 Generated Batch Node 
The batch node in the project configuration should be set to the generated node created by the Batch 

Table Wrapper. 

The batch identifier tag on the Unit Triggers page in the project configuration should be set to the 

internally generated tag called BatchTableWrapper::Batch.  

3.2 Mirrored Batch Node 
The batch node in the project configuration should be set to the PI node via the Batch Table Wrapper 

SimApi. 

The batch identifier tag on the Unit Triggers page in the project configuration should be set to the 

batch identifier in PI via the Batch Table Wrapper SimApi. 

4. Support 
See http://www.umetrics.com/support 

http://www.umetrics.com/support

